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Introduction

PLOTLOG is designed to produce graphical displays associated with the
models of item response theory (IRT), for use in item analysis and
presentation. PLOTLOG draws trace lines (or item characteristic curves),
item- and test-information functions, test characteristic curves, and the
likelihood or posterior densities of item response patterns. The drawings
appear (first of all) on the screen; they may be printed, or exported as files to
other drawing programs for enhancement for use as presentation graphics.
PLOTLOG is intended primarily as an ancillary program for use with
MULTILOG; any of the wide variety of models that can be fitted to data using
MULTILOG may be displayed with PLOTLOG. However, since item
parameters may be entered from the keyboard, PLOTLOG may be used to
provide graphical displays for IRT models fitted with other programs.

Creating graphics in PLOTLOG is a two-step process:

Step 1 Before any plots may be drawn, PLOTLOG must

Enter item parameters  have one or more items’ parameters “in memory.”
Item parameters may be entered from the
keyboard, using the Add Item menu, or by
reading a MULTILOG or BILOG output file, using
Open... under the File menu.

Step 2 After one or more items’ parameters are “in
Create plots memory,” various plots may be drawn by selecting
from the choices in the Plot menu.

While any of the graphics are on the screen, they may be printed by
selecting Print... from the File menu, saved as a PICT file for subsequent
editing by selecting Save As... under the File menu, or copied to the
clipboard by selecting Copy under the Edit menu.

On the following pages, the use of the PLOTLOG menus is summarized.
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The Menus

File

New N
Open... 0
Close

Save S
Save As...

R R

Page Setup...

Print... P
Quit Q

New Selecting New erases all items in
memory.

Open... Activates a standard dialog box to
open a file. All TEXT files will be
displayed, but PLOTLOG can successfully
open only output files fromm MULTILOG or
BILOG. These output files (.SAV files
from MS-DOS or VAX VMS, or SAVE files
from a VM/CMS, or IF.DAT files from
BILOG) must be transferred to the
Macintosh before PLOTLOG is run.l After
a file is opened, the curves for all of the
items in the file will be available in
PLOTLOG's selection windows, identified
by their numbers from 1 to however
many. PLOTLOG does most of its
computation when each item is entered;
there is a substantial delay after opening
a file before the watch cursor is replaced
by the normal arrow.

Close Closes the current window; this is
equivalent to clicking the “close box.”

Save Same as Save As... (below).

Save As... Activates a standard dialog box to
save a file. PLOTLOG saves the image of
the plot currently in the active window
as a PICT file, which can be opened by
common object-oriented drawing
programs for subsequent editing.

Page Setup... Activates a standard dialog box
to set printing attributes.

Print... Activates a standard dialog box to
print the plot in the currently active
window.

Quit Does just that.

IMULTILOG or BILOG output files may be transferred from other systems to the Macintosh
using FTP, Kermit, or any other file transfer system for ASCII (text only) files. Files from
MS-DOS compatible personal computers may be transferred using a wide variety of
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Edit

Undo y4

o RX

Copy

Show Clipboard

Plot

Trace Lines...
Information...
TCC
Posterior...
Selected...

Undo (Currently inactivated.)

Cut (Currently inactivated.)

Copy Copies the contents of the currently
active window to the clipboard.

Show Clipboard (Currently inactivated.)

Trace Lines...

Activates the dialog box

illustrated below; selection of any of the
item numbers in the list (by double-
clicking the item number, or clicking the
item number and then Plot) plots the
item characteristic curve (for binary
items) or all of the trace lines (for
multiple alternative items).

Select Item:

2

4]

(cancel ]

commercially available communications or network software, as well as MS-DOS compatible
disk drives for the Macintosh or Macintosh-compatible disk drives for MS-DOS machines.
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Information... Activates the dialog box illustrated

below; selection of any of the item numbers in
the list (by double-clicking the item number, or
clicking the item number and then Plot) plots
the item’s information function. Any subset of
the items may be (drag or shift-click) selected;
then the total (summed) information function
for that set of items is displayed. Below, both
items 1 and 2 are selected.

PLOTLOG for the Macintosh

S5elect Item:
1 17
2
|| Plot ||
[ Cancel ]
i
TCC Plots the test characteristic curve (TCC) for the

complete set of items in memory. The TCC is
the expected summed score as a function of q.
For binary items, it is computed with item
scores of 0 and 1, so the range of the TCC is O
to the number-of-items. For multiple
alternative items, the item scores are assumed to
run from 1 to the number of alternatives, so the
range of the TCC is from the number-of-items
to the total number-of-alternatives.

Posterior... Activates the dialog box illustrated at

the right. In the box, enter (using the
keyboard) a string of response-numbers, one
number for each item currently in memory. For
binary items, 2 is the positive (correct) response
and 1 is the negative (incorrect) response. For
graded or nominal items, the response
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categories are numbered from 1 to however-
many. For the multiple choice model, the
alternatives are numbered from 2 to however-
many-plus-one (category 1 is latent “don’t
know’). To omit an item from the posterior,
enter zero in that item’s position. Do not press
<return> while entering item responses, or
something very bad happens. If “Likelihood
only” is selected, the product of the item trace
lines (alone) is displayed. If “Gaussian
Population” is selected, you may enter the
mean and standard deviation in the obvious
boxes. If “dohnson Population” is selected,
enter the parameters in the four lowest boxes.
The plot is scaled (by default) so that the
maximum on the y-axis is equal to the ordinate
of the maximum of the posterior; that number
is usually small and unpleasant and is not
displayed. To control scaling (e.g., to make
comparable plots), you may enter a numerical
value for the y-axis maximum in the box
marked ¥Y-axris Maximum.

Enter item responses, as numbers from 1 to the
highest category, in order. Enter zero (D) to
omit an item from the posterior.

Y-axis

Mean:| 0.0

gamma:| .

Maximum: auto || Plot ||

@ Likelihood only
{» Gaussian Population— [ Cancel ]

S$td Dep: | 1.0

{_»Johnson Population— @ S(B) O S(U) O Lognormal

delta:| g.p lambda:| pg.g Hi: | p.0
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Selected... Activates the dialog box illustrated
below. In the box, the numbers of the items
currently in memory are displayed on the left
margin, and the category-numbers for each
item are displayed across the remainder of the
list. You may select (click or shift-click) either
(sets of) item numbers (in which case all of the
selected items’ trace lines are displayed) or (sets
of) categories, in which case the selected trace
lines are shown. Click Plot to see the curves.
Only ten curves may be shown on a single plot;
if more than ten curves are selected, only the
first ten are plotted.

S5elect one or more items (on the left); all trace lines
will be plotted for that item. 0r select individual
cateqories from among those listed on the right.

2 1 2 N

(cancer )

4|
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Add Item

2PL...
SPL...

Graded...

Nominal...
Multiple Choice...

Version 1.0

2PL...

Each of these menu items activates a dialog box
to add an item to the list currently available to
be plotted; in the dialog box, the user is invited
to enter parameters for the specified model.
PLOTLOG does most of its computation when
each item is entered; there may be a substantial
delay after each item is entered before the
watch cursor is replaced by the normal arrow.

For the two-parameter logistic model, enter
the slope (@) and the threshold (b) in the dialog
box, as illustrated below. The form of the
model is T={1+exp[-a(q- b)]}1; note the
absence of “1.7”.

Enter:
b: 0.00
[ Cancel ]
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3PL... For the three-parameter logistic model, enter
the slope (Q), the threshold (b), and the lower
asymptote (c€) in the dialog box, as illustrated
below. The form of the model is
T=c + (1 - c){1+exp[-1.7a(q - b)]}?1; note the
presence of “1.7”.

Enter:
b: | 0.00 [ cancel ]
c: | 0.20
Graded... For the graded logistic model, enter the

slope (@) and the threshold (blk]) parameters;
the model is as documented in the MULTILOG

User’s Guide. Enter the correct number of

categories if the value shown is not already
correct (from the Alternatives menu).

Enter:

bl1]:

b[3]:

b[5]:

b[?]:

b[9]:

bl[2]:
bl4]:
bla]:

blg8]:

e

{ Cancel

-,

o

Mumber of

Categories: | 2
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Nominal... For the nominal model, enter the slope
(alk]) and intercept (c[k]) parameters; the
model is as documented in the MULTILOG
User’s Guide. Enter the correct number of
categories if the value shown is not already
correct (from the Alternatives menu).

Enter:

al1]: cl1]:

al2]: cl2]:

al31: cl31:
al4l: c[4]:

al[5l]: c[5]:
a[6]: cle]:

al?l: c[?l: Number of >
al8]: c[8]: Categories
a[9]: c[9]:
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Multiple Choice... For the multiple choice model,

enter the slope (alkl), intercept (c[kl), and
guessing (d[k]) parameters; the model is as
documented in the MULTILOG User’s Guide.
Enter the correct number of categories (number-
of-alternatives plus one) if the value shown is
not already correct (from the Alternatives
menu).

Enter:

al1l]:

al2]:

al3]:

al4]:

al5]:

al6]:

al?]:

cl[1]:
cl[2]:
c[3]:
c[4]:
c[5]:
cl[6]:

c[?]:

Mumber of
. 2
Categories
d[1]:
d[2]:
1] 4
d[3]: [ ]
d[4]: [ Cancel ]
d[5]:
dl6]:

Alternatives)|

2

(- --REN - W&, R Sy S|
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The checked entry under the Rlternatives
menu is the current default value for the
number of categories when Graded, Nominal,
or Multiple Choice items are added using the
Add Items menu.
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FontSize

10
12
14
18
24

Special

1 ptlines
2 pt lines
Bold

Envelope & M-line

Version 1.0

The checked entry under the FontSize menu is
the current default value for the axis labels.

1 pt lines When checked, the lines on the
plot are drawn 1 point wide; this is good
for most purposes (and printers).

2 pt lines When checked, the lines on the
plot are drawn 2 points wide; this is
useful for very large plots or low-quality
printers, especially when used with Bold.

Bold When checked, all of the plot labels are
in boldface; this is useful for very large
plots or low-quality printers.

Envelope & M-line This option produces
many of the plots described by D.
Thissen & H. Wainer, “Confidence
envelopes for item response theory,”
Journal of Educational Statistics, 1990,
Volume 3, pp. 113-128; see that source
for details on the computation. Selection
of this menu entry activates the dialog
box shown on the following page. The
Envelope & M-line procedures are
completely disconnected from all of the
other plot-making capabilities of
PLOTLOG. It is not possible to use the
parameters entered elsewhere in the
program to generate these plots.
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Enter Parameters:

a: b: C:

3 1PL @ 2PL 3 3PL

(" M-lines @ Logistic Metric | Flot

!

@ Envelopes y Normal Metric

[ Cancel

s

N: (1000 Seed; [B644131

Envelope & M-line (continued) 95% confidence
envelopes and M-line plots may be drawn only
for the 1PL, 2PL, and 3PL models; and the
parameters for those models must be entered in
the dialog box shown above. The model is
selected with the radio buttons marked 1PL,
2PL, and 3PL. Regardless of the model
selected, values must be entered for all three
parameters (a, b, and c); for the 1PL and 2PL
models enter 8.8 for ¢, and for the 2PL model
enter 1.0 for a if the slope is otherwise
unspecified. The radio buttons at the left-center
of the dialog box select either 95% conficence
envelope plots, or M-line plots that
(approximately) fill the 95% envelope with
randomly-generated curves (see Thissen &
Wainer, 1990). The radio buttons marked
Logistic Metric and Normal Metric
determine whether the parameters are
interpreted “using the 1.7” (Normal) or not
(Logistic). The sample size is entered for N,
and the “seed” for the random generation of
M-line plots is entered in the Seed box.
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Details, details...

BEWARE!

Test Information

Version 1.0

This version of the program has generally been fairly
stable. However, like any Macintosh program, it may
(unpredictably) cause complete system crashes. Use it
with care. It appears to run under MultiFinder; but
since the program may crash at any time (possibly
taking the system with it), you are warned against
having unsaved important material in other
applications running simultaneously with PLOTLOG.

The information curves plotted by PLOTLOG involve
only the items. There is no way in the current version
to include the information derived from the
population distribution. If the population
distribution is Gaussian with unit variance, the
information from that source is uniformly 1.0, so in
that event the information plotted by PLOTLOG is
uniformly 1.0 less than the total test information for
EAP or MAP scoring. If the population distribution is
not Gaussian, it is not clear how to supply that
information to PLOTLOG,; that is why the population
distribution is not considered in information curves at
this time.
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Serious editing for
presentation
graphics

PLOTLOG for the Macintosh

PLOTLOG will export its plots, either as PICT files or
through the clipboard, to any of a wide variety of
drawing programs, such as MacDraw, MacDraw I,
Cricket Draw, or SuperPaint (to name a few of the
more common). All of these programs exceed any
drawing or formatting capabilities PLOTLOG could
ever have; therefore PLOTLOG will never have any
such features. To edit plots for use in publication or
presentation, export the graphics to your favorite
drawing program and “fix it up” there. For
convenience, the curves generated by PLOTLOG are
“polygons,” and they can be “smoothed” by drawing
programs with the facilities to do so. Simply select
the curves (or the entire graphic) in the drawing
program and then select “smooth” from the
appropriate menu. PLOTLOG does not “smooth” the
curves; it plots only 28-straight-line-segment
approximations. The 28-segment approximations
look fairly curved on the screen or a dot matrix
printer, but they may have noticeable discontinuities
when printed on a laser printer.
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An Example

How-to-make what became Figure 4.5 of Computerized Adaptive Testing:
A Primerl, using PLOTLOG and MacDraw; see page 21 for the result.

First, start PLOTLOG and use the FontSize menu to make the labels 18
points (big).

Then, enter the parameters for the two items that are to become A and C; we
chose to make the slope 1.0 for both, with ba = 0.0 and b¢c = 0.5. To do this,

select 2PL... under the AddItem menu, and click 0K in the following dialog
box:

Enter:

b: | 0.00
[ Cancel ]

Then, select 2PL... again, and insert 8.5 in the box for b, and click 0K:

Enter:

[ Cancel ]

1H. Wainer, N. Dorans, R. Flaugher, B. Green, R. Mislevy, L. Steinberg & D. Thissen (Eds.),
(1990). Computerized adaptive testing: A primer. Hillsdale, NJ: Lawrence Erlbaum Associates.
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Now the two items are “in memory” and we are ready to start making

pictures. The first one will be the standard normal for N; to make this one,
select Posterior... under the Plot menu, and respond in the dialog box as

follows:

Enter item responses, as numbers from 1 to the
highest category, in order. Enter zero (0) to
omit an item from the posterior.

o0

Y-axis

Mean:

MaHimum:
{_» Likelihood only
(@ baussian Population—

auto

0.0

gamma:

0.0

5td Dep:

delta:

1.0

{yJohnson Population— @& S(B)

0.0

_ 5(U)

ot )

{_) Lognormal

lambda:

0.0

Hi:

0.0

Note the entry of the two zeros in the responses-box; this makes the two
items missing, so the posterior is the prior, which is N(0,1). Click Plot and
the picture appears.

It is best to resize the PLOTLOG drawing window at this point, so it is about

2.5 inches tall.

PLOTLOG for the Macintosh
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Then select Save as... under the File menu, to save the graphic as N.pict
(for later use):

= PlotLog
by Protiagiiad — DTs 80Meq
Py Plattogiooni - _
fr Prottooioout g
P Prottopiooei g N
Py Plotiogiorgi -4
Py Flatbogirang
Save PICT file as
N.pict | Cancel |

Now, we need to create the trace-line plot for A. The easiest way to do this is
to use Selected... under the Plot menu, which gives this dialog box:

Select one or more items (on the left); all trace lines
will be plotted for that item. 0Or select individual
categories from among those listed on the right.

1 1 5

[ Cancel ]

o

Next to item 1 (top row; remember, this is item A), click 2 (because that is
“correct”), and then click Plot. The plot appears. While it is on the screen,
select Save as... and save the graphic as A.pict, as above. Then repeat this
process exactly to get the plot of the trace line for C, except in the dialog box
like that immediately preceding, click 2 for item 2 (C, second row of the
items-to-be-selected). Save that plot as C.pict.
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Now we are ready to do the posterior. Select the Posterior... menu item
under Plot, and the following dialog box appears; fill in 22 in the responses-
box to indicate the posterior for “both correct.” Also, replace the word
“auto” with “1.8” in the “Y-aris Maxrimum” box. Because the PLOTLOG-
height of the original normal prior is 1.0, this makes the posterior come out
the right-fraction-of-the-height of the original normal. If you leave it on
“auto” the posterior will be as tall as the y-axis.

Enter item responses, as numbers from 1 to the
highest category, in order. Enter zero (0) to
omit an item from the posterior.

22

¥Y-axis
{_» Likelihood only
i@ Gaussian Population— [ Cancel ]

Mean:| 0.0 S$td Dep: | 1.0
»Johnson Population— ® S(B) O S(U) O Lognormal

gamma:| pg.g delta:| pg.p lambda:| pg.g Hi: | 0.0

Click Plot and the graphic appears on the screen. Then Save as... P.pict,
and Quit PLOTLOG.
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Now, start a drawing program; | used MacDraw. Always, first: Turn Grid
Off! We are going to be doing a lot of “moving grouped things around” and
if the snap-to-grid is on, the relative positions of all the elements will be
thrown off by snapping to the nearest (invisible) grid line every time
something moves. In MacDraw, the grid must be turned off each time a new
file or window is opened, because it always defaults to be on.

Ok, now Open... N.pict (created previously in PLOTLOG). That file looks
like this:

0.0 . . . . . .
-3 -2 -1 0 +1 +2 +3
q

Delete the g. Save as..., naming it Figure4.5 (to title this window).

Now, Open A.pict; delete the g, and replace the T(x) with A, after which it
looks like this:

1.0

A 0.5

0.0 : : : : . .
-3 —2 -1 0 +1 +2 +3

Then Select All, Group and Copy the whole thing to the Clipboard; and
Paste it where it goes in Figure4.3. Repeat this process in the obvious way

for C.pict.
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Now open P.pict; it looks like this:

0.0 . . : : . .
-3 —2 -1 0 +1 +2 +3
g

Leave the g on the bottom of this one, and repeat the maneuvers that place
it on the bottom of Figure4.5.

Now, slide all four of the plots around in Figure4.5 until their y-axes line
up vertically and they are equally-spaced. Finish putting the labels in.

When they are appropriately positioned (but not before!) select each of the
four plots and UnGroup them. Then, Select All and choose “Smooth”
from the Edit menu. This will “smooth” the four curves (replace the
straight-line-segments with splines). Do this last, because after the curves are
smoothed working with the MacDraw display gets really slow, as every time
it scrolls it recomputes the splines.

Print it and it’s finished. The result is shown on the following page.
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0.0

3 2 - 0 +1  +2  +3
1.0
0.5
0.0 |

3 2 0 +1 42 +3
1.0
0.5
0.0 |

3 2 0 +1 +2  +3
0.0 |

3 -2 0 +1  +2  +3

q
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